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ESD sensitive device 

All front-panel connectors of the 

M8192A and the M8190A/M8121A 

are sensitive to Electrostatic 

discharge (ESD). We recommend to 

operate the instrument in an 

electrostatic safe environment.  

There is a risk of instrument 
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connector.  

Please follow this instruction:  

Before touching the front-panel 

connectors, discharge yourself by 

touching the properly grounded 

mainframe. 
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Software is delivered and licensed as 
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the U.S. Government will receive no 

greater than Restricted Rights as 

defined in FAR 52.227-19(c)(1-2) 
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Safety Notices 
 

 

A CAUTION notice denotes a 

hazard. It calls attention to an 

operating procedure, practice, 

or the like that, if not correctly 

performed or adhered to, could 

result in damage to the product 

or loss of important data. Do not 

proceed beyond a CAUTION 

notice until the indicated 

conditions are fully understood 

and met.  

A WARNING notice denotes a 

hazard. It calls attention to an 

operating procedure, practice, 

or the like that, if not correctly 

performed or adhered to, could 

result in personal injury or 

death. Do not proceed beyond a 

WARNING notice until the 

indicated conditions are fully 

understood and met. 

CAUTION 

WARNING 

http://www.keysight.com/find/assist


 

 

Safety Summary 

 

General Safety 

Precautions 
 

 

The following general safety precautions must be observed during all phases of 

operation of this instrument. Failure to comply with these precautions or with 

specific warnings elsewhere in this manual violates safety standards of design, 

manufacture, and intended use of the instrument. For safe operation the general 

safety precautions for the M9502A and M9505A AXIe chassis, must be followed. 

See: http://www.keysight.com/find/M9505A Keysight Technologies Inc. assumes 

no liability for the customer's failure to comply with these requirements. Before 

operation, review the instrument and manual for safety markings and instructions. 

You must follow these to ensure safe operation and to maintain the instrument in 

safe condition. 

Initial Inspection 

 

Inspect the shipping container for damage. If there is damage to the container or 

cushioning, keep them until you have checked the contents of the shipment for 

completeness and verified the instrument both mechanically and electrically. The 

Performance Tests give procedures for checking the operation of the instrument. If 

the contents are incomplete, mechanical damage or defect is apparent, or if an 

instrument does not pass the operator’s checks, notify the nearest Keysight 

Technologies Sales/Service Office.  

WARNING To avoid hazardous electrical shock, do not perform electrical tests 

when there are signs of shipping damage to any portion of the outer enclosure 

(covers, panels, etc.). 

General 

 
This product is a Safety Class 3 instrument. The protective features of this product 

may be impaired if it is used in a manner not specified in the operation 

instructions. 

Environment 

Conditions 
This instrument is intended for indoor use in an installation category II, pollution 

degree 2 environment. It is designed to operate within a temperature range of  0 

°C – 40 °C (32 °F – 105 °F) at a maximum relative humidity of 80% and at altitudes 

of up to 2000 meters. 

This module can be stored or shipped at temperatures between -40 °C and +70 °C. 

Protect the module from temperature extremes that may cause condensation 

within it. 

Before Applying Power Verify that all safety precautions are taken including those defined for the 

mainframe. 

Line Power 

Requirements 
The Keysight M8192A and the M8190A/M8121A operates when installed in an 

Keysight AXIe mainframe. 

Do Not Operate in an 

Explosive Atmosphere 
Do not operate the instrument in the presence of flammable gases or fumes. 

 

Do Not Remove the 

Instrument Cover 
Operating personnel must not remove instrument covers. Component replacement 

and internal adjustments must be made only by qualified personnel. Instruments 

that appear damaged or defective should be made inoperative and secured 

against unintended operation until they can be repaired by qualified service 

personnel. 

http://www.agilent.com/find/M9505A


 

 

Safety Symbols 
 

 Table 1 Safety Symbol 

Symbol Description 

 

Indicates warning or caution. If you see this symbol on a product, you must refer to the manuals for 

specific Warning or Caution information to avoid personal injury or damage to the product. 

 

 

C-Tick Conformity Mark of the Australian ACA for EMC compliance. 

 

 

CE Marking to state compliance within the European Community: This product is in conformity with the 

relevant European Directives. 

 

 

General Recycling Mark 

 

 

 

 

 Table 2 Compliance and Environmental Information 

Symbol Description 

 

This product complies with the WEEE Directive (2002/96/EC) marketing requirements. The affixed label 

indicates that you must not discard this electrical/electronic product in domestic household waste.  

Product category: With reference to the equipment types in the WEEE Directive Annexure I, this product 

is classed as a “Monitoring and Control instrumentation” product.  

 

Do not dispose in domestic household waste.  

 

To return unwanted products, contact your local Keysight office, or see 

http://about.keysight.com/en/companyinfo/environment/takeback.shtml for more information. 

 

 
 

 

http://about.keysight.com/en/companyinfo/environment/takeback.shtml
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Introduction This chapter provides an overview of Keysight M8192A module. 

The M8192A synchronization module is used together with 2 to 6 M8190A/M8121A 

modules to build a fully synchronous, phase coherent multi-channel generator 

system with up to 12 analog channels and 24 marker outputs. 

When running in synchronous mode, all of the M8190A/M8121A modules work with 

the same sample clock and start at the same time. One of the M8190A/M8121A 

modules is designated as the “master” module and the remaining 1 to 5 modules as 

“slave”. The common sample clock is derived either from the master module’s 

internal clock synthesizer or from an external sample clock that is connected to the 

master module’s sample clock input. 

The skew between any two channels is guaranteed to be within +/- 20 ps (without 

system level calibration) independent of the sample rate. Using the fine delay adjust 

capability of the M8190A/M8121A with 50 fs resolution, the skew can be adjusted to 

less than 1 ps between any two channels. Once adjusted, the skew is maintained 

across loading new waveforms, changing sample rate and power cycles to better 

than 2 ps.  

A common trigger input is available on the synchronization module to trigger all the 

connected M8190A/M8121A modules simultaneously with deterministic latency. 

Triggered waveforms have the same inter-channel skew as continuous waveforms. 

To achieve the lowest possible trigger delay uncertainty, the trigger input can be 

synchronized externally to the SYNC CLK output.  

The M8192A module has its own Soft Front Panel but no extra firmware like the 

M8190A which allows you to control the trigger mode, trigger level and common 

start/stop of the multi-module setup.  
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Features and Benefits M8192A provides following features and benefits:  

• Synchronization of up to 6 M8190A/M8121A modules (= 12 channels) 

• One trigger input can trigger up to 6 M8190A/M8121A modules with 

deterministic latency  

• Skew repeatability of 2 ps between any two channels – independent of 

sample rate 

• Skew resolution of 50 fs between any two channels 

• 1U AXIe module for high port density 

 

 
Additional Documents Additional documentation can be found at:  

• http://www.Keysight.com/find/M9505A for 5-slot chassis related 

documentation. 

• http://www.Keysight.com/find/M9502A for 2-slot chassis related 

documentation. 

• http://www.Keysight.com/find/M9045A for PCIe laptop adapter card 

related documentation. 

• http://www.Keysight.com/find/M9047A for PCIe desktop adapter card 

related documentation. 

• http://www.Keysight.com/find/M9536A for embedded AXIe controller 

related documentation. 

• http://www.Keysight.com/find/M8190A for AXIe based AWG module 

related documentation. 

• http://www.Keysight.com/find/M8121A for AXIe based AWG module 

related documentation. 

 

1.1 Document History 

 
Edition 1.0  

(October 2013) 
Edition 1.0 of the user guide describes the functionality of firmware version 3.0.  

Edition 2.0 

(December 2013) 
Edition 2.0 of the user guide describes the functionality of firmware version 3.0.  

Edition 3.0  

(April 2014) 
Edition 3.0 of the user guide describes the functionality of firmware version 3.2.  

Edition 4.0  

(November 2014) 
Edition 4.0 of the user guide describes the functionality of firmware version 5.0.  

Edition 5.0 

(February 2015) 
Edition 5.0 of the user guide describes the functionality of firmware version 5.0.  

Edition 6.0 

(June 2017) 
Edition 6.0 of the user guide describes the functionality of firmware version 5.4. 

Edition 7.0 

(October 2017) 
Edition 7.0 of the user guide describes the functionality of firmware version 5.4. 

Edition 8.0 

(January 2020) 
Edition 8.0 of the user guide describes the M8192A support with M8121A. 

Edition 9.0 

(February 2020) 
Edition 9.0 - Removed Win 8.1 support references from the document. 

  

http://www.agilent.com/find/M9505A
http://www.agilent.com/find/M9502A
http://www.agilent.com/find/M9045A
http://www.agilent.com/find/M9047A
http://www.agilent.com/find/M9536A
http://www.agilent.com/find/M8190A
http://www.keysight.com/find/M8121A
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1.2 Accessories 

 

 The M8192A is delivered with three clock cables and two trigger cables to build a 4-

channel synchronous system using two M8190A/M8121A. To synchronize more than 

two M8190A/M8121A, additional clock and trigger cables must be ordered, as listed 

in the following table. 

 

 Table 3 Accessories for M8190A/M8121A synchronization  

Number of M8190A/M8121A in the 

Synchronous System 

Additional M8192A-801  

Clock Cables Needed 

Additional M8192A-802 Trigger Cables 

Needed 

2 None  None 

3 1 1 

4 2 2 

5 3 3 

6 4 4 

 

 

 

1.3 M8192A Front Panel 

 

 The following figure shows the front panel of the M8192A module: 

 

 

 

 Figure 1   Front Panel of M8192A 

 

 

Inputs/Outputs The inputs and outputs available on the front panel of the M8192A module are 

described in  Table 4. 
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 Table 4 Inputs and Outputs available on the front panel of the M8192A module  

Input/Outputs  Description Connector Type 

SYS CLK IN Connect to SYS CLK OUT of the M8190A/M8121A master module Proprietary multi-coax 

SYS CLK OUT Connect to SYS CLK IN of M8190A/M8121A master module and 

M8190A/M8121A slave module 

Proprietary multi-coax 

SYNC CLK OUT Optional: Connect to external DUT SMA 

TRIGGER IN Optional: Connect Trigger signal from external DUT for 

synchronous external triggering across all M8190A/M8121A 

modules 

SMA 

TRIGGER OUT Connect to TRIGGER IN of M8190A/M8121A master module and 

M8190A/M8121A slave module 

QMA 

 

 

Status LED Two LEDs are available at the front panel to indicate the status of the M8192A 

module:  

The green “Access”LED indicates that the controlling PC exchanges data with the 

M8192A module.  

The red “Fail”LED has following functionality: 

• It is “ON” for about 30 seconds after powering the AXIe chassis. 

• After about 30 seconds the LED is switched “OFF”. If an external PC is used 

to control the AXIe chassis, this PC can be powered after this LED has 

switched OFF. 

• During normal operation of the module this LED is “OFF”. In case of an error 

condition such as e.g. a self-test error, the LED is switch “ON”. 

In case the output relay has shut-off because of an external overload condition, this 

LED flashes.  
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2.1 Introduction 

 

 This chapter explains the steps required to install M8192A module.  

 

 

2.1.1 Pre-Requisites 

 

 The following are the pre-requisites for installing Keysight M8192A software:  

• The supported operating systems are: 

− Windows 10 (32 bit or 64 bit)  

 

• Ensure that you have Keysight IO Libraries Suite Version 16.3 or higher 

installed on your system. The Keysight IO Libraries Suite can be found on 

the CD that is part of shipment content or at 

http://www.Keysight.com/find/iosuite. 

 

  

http://www.agilent.com/find/iosuite
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2.1.2 Installation Process 

 

 Follow the given steps to install M8192A module on your system: 

 

1. Double-click the executable (M8192_Setup.exe). This executable file will be 

available on either CD or Web. 

 

 

 

2. The Keysight M8192A Setup will prepare the InstallShield Wizard for the 

installation process. The following window will appear. 
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 3. Follow the onscreen instructions to begin the installation process. Click 

Next. 

 

 

 

4. We recommend you read the document to check if your hardware 

configuration is supported.  

Click Next to proceed to the license agreements. 
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 5. Accept the terms of Keysight software end-user license agreement. Click 

Next. 

 

 

 

6. Accept the terms of Keysight IVI Driver Source Code license agreement. 

Click Next. 
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 7. Select Yes if you want to read the post-installation instructions.  

Click Next. 

 

 
 

8. Select a setup type either Complete or Custom.    

Click Next. 
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9. Click Install to begin installation. 

 

 

 

10. The Keysight M8192A will configure the new software installation. 
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11. The following screen will appear once the Keysight M8192A software is 

successfully installed on your system. Click Finish to restart your system. 

 

 

 

This completes the Keysight M8192A software installation. 

  



M8192A Installation  2 

Keysight M8192A User’s Guide  23 

2.1.3 Post Installation Steps 

 

 
If your instrument is already powered up and connected to your PC using the PCIe 

cable, just reboot your PC and start with step 5. 

 
 

 

 Follow the post installation steps as shown below:  

1. Shut down PC and instrument.  

2. Connect instrument to PC using the PCIe cable.  

3. Switch on instrument. Wait until the “Access” LED of the M8192A has 

switched from red to green.  

4. Switch on PC.  

5. The PC should automatically recognize the instrument.  

Check this in the device manager; e.g. via Computer  Manage  Device 

Manager:  

The instrument should be visible in the device tree as Keysight  M8192. 

 

 

 
Your PC might request a reboot. Reboot your PC, if requested. 

 
 

 

 6. Check if the M8192 is also visible in the Keysight Connection Expert: 

e.g. via Start Menu  Keysight IO Libraries Suite  Keysight Connection 

Expert. 

If something went wrong and the Instrument is not shown in the PXI 

section, it may be necessary to reboot the PC once more.  
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2.1.4 How to Control the Instrument 

 

 To control the instrument: 

1. Start the Soft Front Panel (Start > All Programs > Keysight > M8192 > 

M8192 Soft Front Panel). 

2. A dialog will open, in which you can select your instrument. 

3. Add Keysight M8190A/M8121A instruments to the system and connect 

them to the M8192. 

4. Use Help > About to get information about available remote connections. 

 

 

2.2 AXI Chasis 

 

 The detailed documentation for the AXIe chassis can be found at:  

• http://www.Keysight.com/find/M9505A for 5-slot chassis 

• http://www.Keysight.com/find/M9502A for 2-slot chassis. 

 

 

2.2.1 ESM Front Panel Connector 

 

 The ESM Front Panel Connector is shown in the figure below: 

 

 

1 2 3 4 5 6 7 8 9

 
  

http://www.agilent.com/find/M9505A
http://www.agilent.com/find/M9502A
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1 PCle Connects a host PC to the chassis via PCle. 

PCIe is the only interface that can be used to control the M8192A 

module. 

2 Multiframe Input Synchronizes timing signals with multiple daisy-chained chassis. 

These signals are not needed to synchronize M8190A/M8121A 

modules. The M8192A synchronization module is needed instead. 
3 Multiframe Output 

4 Trigger In External Trigger connections. 

The Trigger In of the AXIe ESM cannot be used to trigger the M8192A. 

The M8192A has its own Trigger In. 

The Trigger Out of the AXIe ESM cannot be controlled by the M8192A. 

5 Trigger Out 

6 Clock In 
External clock connections. 

7 Clock Out 

8 LAN Connects the host PC to the chassis, via 10/100/1000 Ethernet.  

In particular, the LAN connector is used for ESM configuration, but 

NOT to communicate to the M8192A. 

9 Status Light Indicates the chassis status. 
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3.1 Introduction 

 

 This chapter describes how to configure a synchronous system. The term 

‘synchronous system’ describes multiple M8190A/M8121A AWG modules that 

operate entirely synchronous with respect to timing parameters including 

synchronous start, synchronous sequencing, common trigger and common sample 

clock. A synchronous system consists of: 

• M8192A synchronization module 

• One M8190A/M8121A AWG master module 

• One or up to five M8190A/M8121A AWG slave modules 

• One or more M9502A 2-slot AXIe chassis or M9505A 5-slot AXIe chassis 

• An external PC to control the synchronous system 

• Trigger cables and clock cables to synchronize all modules in the system 

• M8192A software that controls the synchronous operation of the system 

 

 

 
Any M8190A/M8121A module may become a master module or slave module by 

software configuration and by connecting external cables accordingly. 

 
 

 The M8192A synchronization module is designed to synchronize up to six 

M8190A/M8121A arbitrary waveform generator modules. The M8190A/M8121A 

modules can be in the same or different AXIe chassis as the M8192A. This allows very 

flexible configurations to address a variety of applications. 

A synchronous trigger signal to start the system synchronously and a common clock 

signal is distributed using special cables. These cables are connected on the front 

panel between the M8192A synchronization module and the M8190A/M8121A 

arbitrary waveform generator modules. 

All synchronous system configurations require an external desktop PC or laptop PC 

with PCIe interface cable connection to control the system. In case of multiple AXIe 

chassis configurations, a desktop PC with two or even three PCIe adapters is 

required.  

Any even and odd number of up to 12 Arbitrary Waveform Generator channels can 

be configured using a combination of 1-channel and 2-channel M8190A/M8121A 

Arbitrary Waveform Generators (see section 3.2). Typical multi-channel 

configurations are described in the following subchapters: 

 

 

3.1.1 4 M8190A/M8121A Arbitrary Waveform Generator Channels 

 

 To configure a synchronous system with 4 channels, use one 5-slot AXIe chassis, one 

M8192A and two M8190A/M8121A 2-channel Arbitrary Waveform Generator 

modules. 

This configuration can be ordered as a pre-configured M8190A/M8121A’s multi-

channel AWG system. 
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3.1.2 6 (or 8) M8190A/M8121A Arbitrary Waveform Generator Channels 

 

 To configure a synchronous system with 6 (or 8) channels, use two 5-slot AXIe 

chassis, one M8192A and 3 (or 4) M8190A/M8121A 2-channel Arbitrary Waveform 

Generator modules. This synchronous system can be controlled from one external PC 

that supports two PCIe adapter cards. 

This 8-channel configuration can be ordered as a pre-configured M8190A/M8121A’s 

multi-channel AWG system. 

 

 

3.1.3 10 (or 12) M8190A/M8121A Arbitrary Waveform Generator Channels 

 

 To configure a synchronous system with 10 (or 12) channels, use three 5-slot AXIe 

chassis, one M8192A and 5 (or 6) M8190A/M8121A 2-channel Arbitrary Waveform 

Generator modules. This synchronous system can be controlled from one external PC 

that supports three PCIe adapter cards. 

 

 

3.2 Supported AXIe Frame Combinations 

 

 Besides the typical and most common synchronous system configurations described 

in chapter 3.1 the synchronous system configuration is not limited to these examples. 

A general configuration of a synchronous system can be configured by a combination 

of up to seven M9502A 2-slot AXIe chassis and M9505A 5-slot AXIe chassis.  

The trigger and clock cables needed for the synchronous system are limited in 

physical length. As a result, when using three or more AXIe chassis to configure a 

synchronous system, the M8192A synchronization module must be inserted in the 

middle AXIe chassis.   

Due to limited physical length of the trigger cables and clock cables, synchronous 

systems as listed in  Table 5 can be configured. 
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 Table 5 Valid Synchronous System Configurations 

Number of 

M8192A 

Number of 

M8190A/M8121A 

Supported AXIe Chassis Combinations 

1 2 Three M9502A 2-slot AXIe chassis or 

One M9505A 5-slot AXIe chassis or 

Two M9505A 5-slot AXIe chassis  

1 3 Four M9502A 2-slot AXIe chassis or  

One M9505A 5-slot AXIe chassis plus one M9502A 2-slot AXIe chassis or  

Two M9505A 5-slot AXIe chassis  

1 4 Five M9502A 2-slot AXIe chassis or  

One M9505A 5-slot AXIe chassis plus two M9502A 2-slot AXIe chassis or  

Two M9505A 5-slot AXIe chassis  

1 5 Six M9502A 2-slot AXIe chassis or  

One M9505A 5-slot AXIe chassis plus three M9502A 2-slot AXIe chassis or  

Two M9505A 5-slot AXIe chassis plus one M9502A 2-slot AXIe chassis  

1 6 Seven M9502A 2-slot AXIe chassis or  

One M9505A 5-slot AXIe chassis plus four M9502A 2-slot AXIe chassis or  

Two M9505A 5-slot AXIe chassis plus two M9502A 2-slot AXIe chassis or  

Three M9505A 5-slot AXIe chassis  
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3.3 Controlling One AXIe Chassis 

 

 This section describes the basic configuration of a synchronous system with four 

synchronous M8190A/M8121A AWG channels, however  Figure 2 displays 

the configuration with M8190A. 

 

 

 

 Figure 2   One AXIe chassis connected to external host PC 

 

 A synchronous system with four synchronous M8190A/M8121A AWG channels 

consists of: 

• Two M8190A/M8121A 2-channel arbitrary waveform generator modules 

• M8192A synchronization module. The delivery content of the M8192A 

synchronization module includes: 

− Three clock cables with proprietary multi-coax connectors at each side. 

See  Figure 3. 

− Two trigger cables with a QMA connector at one end and a SMA 

connector at the other end. See  Figure 4. 

• M9505A AXIe chassis 

• External controlling PC including PCIe IF card and PCIe cable 

 

 

 Figure 3   M8192A-801 proprietary multi-coax clock cable 
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 Figure 4   M8192A-802 QMA to SMA trigger cable 
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3.4 Controlling Multiple AXIe Chassis 

 

 A synchronous system that consists of multiple (more than one) AXIe chassis can be 

controlled in the following two ways: 

• One PC controls multiple chassis 

• Multiple PCs control multiple chassis 

 

 

3.4.1 One PC Controls Multiple Chassis 

 

 If you are using multiple AXIe chassis (any combination of the Keysight M9502A 2-

Slot or M9505A 5-Slot chassis) connected to your PC, Keysight Connection Expert 

finds both the chassis at the same local IP address 

(TCPIP0::169.254.1.0::5052:SOCKET). Refer to  Figure 5. 

 

 

 

 Figure 5   Multiple AXIe chassis connected to external host PC 

 

 Keysight Connection Expert finds both chassis but since the IP addresses are the 

same, it is impossible to use the Chassis Web Interface, Soft Front Panel, or specify a 

chassis for programming. 

 
 

 If you have two or more AXIe chassis, the solution is to connect them to an optional 

switch or hub as shown in  Figure 6. 

In this scenario, the Host PC must connect to the same network hub or switch as the 

AXIe chassis. 
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 Figure 6   Using a LAN switch for multiple AXIe chassis 

 
 

 Although it is not required, manually assigned a unique, static IP address in the 

optional switch, will speed up network resolution at Windows startup and eliminate 

any potential network resolution issues. 
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3.4.2 Multiple PC Controls Multiple Chassis 

 

 The configuration where multiple PCs are used to control multiple AXIe chassis may 

be used to increase the data throughput over each PCIe link from the host PC to the 

AXIe chassis. Streaming applications that require multiple synchronous AWG 

channels can exploit this type of configuration to increase the streaming throughput 

to each AWG channel. 

If you have multiple PCs that are connected to multiple AXIe chassis, each PC 

controls one AXIe chassis over PCIe using an M9048A PCIe IF card. 

The “Master” PC that controls the M8192A over PCIe, controls the “Slave” PCs using 

the LAN IF card. 

 

 

 

 Figure 7   Multiple PCs controls multiple AXIe chassis 

 

 
Figure 7 displays the configuration with M8190A module, similar configuration can 

be done using the M8121A module. 
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3.5 Synchronous System Cabling 

 

 This section describes the cable connections of an eight-channel synchronous 

system. An eight-channel synchronous system consists of: 

• Four M8190A/M8121A 2-channel arbitrary waveform generator modules 

• M8192A synchronization module. The delivery content of the M8192A 

synchronization module includes: 

− Five clock cables with proprietary multi-coax connectors at each side.  

− Four trigger cables with a QMA connector at one end and a SMA 

connector at the other end.  

• Two M9505A AXIe chassis 

• External controlling PC including PCIe IF card and PCIe cable 

 

 Figure 8 depicts the eight-channel synchronous system cabling. 

 

 

 

 Figure 8  System level cabling of an eight-channel synchronous system 

 

 

 
The highlighted cables in the synchronous system cabling are described in  

 

 Table 6. 
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 Table 6 Cable Connections 

Cable 

No. 

Cable Type Source Destination 

1 Proprietary multi-coax Master module: SYS CLK OUT Sync module: SYS CLK IN 

2 Proprietary multi-coax Sync module: SYS CLK OUT Master module: SYS CLK IN 

3-5 Proprietary multi-coax Sync module: SYS CLK OUT Up to 5 slave modules:  

SYS CLK IN 

6 SMA to SMA Sync module: SYNC CLK OUT Device Under Test (DUT) 

7 SMA to SMA Device Under Test (DUT) Sync module: Trigger IN 

8 QMA to SMA Sync module: TRIGGER OUT Master module: Trigger IN 

9-11 QMA to SMA Sync module: TRIGGER OUT Up to 5 slave modules: Trigger IN 

 

 

3.6 Controlling the Synchronous System 

 

 This section describes the ways to control the synchronous system.  

 

 

3.6.1 Requirements for Controlling the Synchronous System 

 

 The requirements for controlling the synchronous system are as follows: 

• Any remotely controlled M8190A/M8121A module that will become part of 

the synchronous system must be made visible in ACE (Keysight Connection 

Expert) 

• The M8190A/M8121A firmware of each module of the synchronous system 

must be started prior to configuring the synchronous system.  

• SYS CLK outputs of the M8192A must be used in ascending order without 

leaving a gap. Example: For four M8190A/M8121A, SYSCLK OUT 1, SYSCLK 

OUT 2, SYSCLK OUT 3 and SYSCLK OUT 4 must be connected. 

 

 

3.6.2 Synchronous System Operation Modes 

 

 The synchronous system has the following two modes of operation: 

1. Configuration mode 

2. Operation mode  
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3.6.2.1 Configuration Mode 

 

 The configuration mode is used while connecting external cables of the synchronous 

system or during configuration of main parameters such as setting the common 

sample clock frequency that affects the entire synchronous system. Specifically, 

when defining which M8190A/M8121A found by Keysight Connection Expert (ACE) 

modules belong to the synchronous system or to determine which M8190A/M8121A 

is the master module or a slave module or when system parameters (see section 

3.6.3.2) are being changed, the system must be stopped and set in configuration 

mode: 

 

 

3.6.2.2 Operation Mode 

 

 The operation mode is used for data generation and to synchronously start the 

system. To start data generation, you must switch to operation mode. 

Whenever the user switches from configuration mode to operation mode, following 

system checks and actions are performed: 

• Verify that the firmware version of all M8190A/M8121A AWG modules and 

the M8192A synchronization module of the synchronous system is identical 

and higher than V3.0.0 

• Verify that each M8190A/M8121A of the synchronous system has a 

common set of options. E.g. all M8190A/M8121A of the synchronous 

system must operate in the same bit mode. I.e. when operating the 

synchronous system in 14-bit mode, option -14B must be installed on each 

M8190A/M8121A of the synchronous system. When operating the 

synchronous system in interpolation mode,  

option -DUC must be installed on each M8190A/M8121A of the 

synchronous system. 

• Each M8190A/M8121A in the synchronous system measures the frequency 

of the sample clock and synchronization clock. As a result, correct cabling 

of the clock cables is verified. 

• Verify that a trigger propagates from the M8192A synchronization module 

to each M8190A/M8121A of the synchronous system. As a result, correct 

cabling of the trigger cables is verified. 

• Transfer the settings of sample frequency, bit mode (including interpolation 

factor) to the slave modules. 

• Set arm mode of all the modules in the synchronous system to “Armed”. 

• Set trigger mode of all the modules in the synchronous system identical to 

the trigger mode of the controlling M8192A module. 

• Perform accurate delay alignment among all M8190A/M8121A channels in 

the synchronous system. 
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3.6.3 Control Parameters 

 

 In a synchronous system, many parameters such as the common sample clock 

frequency cannot be adjusted individually on each M8190A/M8121A AWG module. 

Otherwise, synchronous operation would not be possible.  This section describes how 

to control parameters that affect the entire synchronous system. This section 

describes as well if a specific system parameter is modified by the M8192A or the 

M8190A/M8121A. 

 

 

3.6.3.1 Using M8192A Soft Front Panel 

 

 The Soft Front Panel of the M8192A lists all M8190A/M8121A that are available in 

the local PC or in ACE in a table. Using this table, the user can define that a certain 

M8190A/M8121A will be,  

• Part of the synchronous system (or will not be part) 

• The master module 

• The slave module 

Following parameters can be controlled using the M8192A Soft Front Panel: 

• Trigger mode 

• Trigger threshold 

• Trigger input impedance 

• Trigger input enable  

• Synchronous start and stop of all M8190A/M8121A modules in the system 

by software 

 

 

3.6.3.2 Using M8190A Soft Front Panel 

 

 The following parameters that affect the entire synchronous system can be 

controlled from the M8190A master module.  

• Sample Clock Frequency  

• Sample Clock Source (Internal or External) 

• Reference Clock Source (Backplane, Reference CLK In, Internal) 

• Output Mode (14bit or 12 bit or interpolation mode and interpolation factor) 

Above parameters are disabled in the M8190A slave modules. To modify above 

parameter, you need to switch to configuration mode first.  
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3.6.3.3 Using M8121A Soft Front Panel 

 The following parameters that affect the entire synchronous system can be 

controlled from the M8121A master module.  

• Sample Clock Frequency  

• Sample Clock Source (Internal or External) 

• Reference Clock Source (Backplane, Reference CLK In, Internal) 

• Output Mode (14bit or 12 bit or interpolation mode and interpolation factor) 

Above parameters are disabled in the M8121A slave modules. To modify above 

parameter, you need to switch to configuration mode first.  

 

 

3.6.3.4 Parameters controlled from M8192A and M8190A/M8121A 

The  Table 7 lists the common synchronous system parameters that can be 

controlled by the M8192A or M8190A/M8121A. 

 

 Table 7  Parameters controlled from M8192A and M8190A/M8121A 

Functionality M8192A Synchronization Module M8190A/M8121A Master Module M8190A/M8121A Slave Module 

Sample frequency Not available Controls all M8190A/M8121A. 

Modification is only possible in 

configuration mode 

Disabled 

Output Mode :14 bit or 12 bit 

or interpolation mode  

(INTx3, INTx12, INTx24 or 

INTx48) 

Not available Controls all M8190A/M8121A. 

Modification is only possible in 

configuration mode 

Disabled 

Coupling between channels All M8190A/M8121A always 

operate in coupled mode 

Coupled mode is always turned on by 

the M8192A and uncoupled mode is 

disabled 

Coupled mode is always turned on 

by the M8192A and uncoupled 

mode is disabled 

Arm mode All M8190A/M8121A must operate 

in arm mode ‘self’ (arm mode 

‘armed’ is not supported) 

Arm mode ‘armed’ is disabled Arm mode ‘armed’ is disabled 

Trigger mode All M8190A/M8121A must operate 

in triggered or continuous mode 

(gated is not enabled) 

Gated is not selectable Gated is not selectable 

Trigger Threshold Affects all M8190A/M8121A Disabled Disabled 

Trigger Impedance Affects all M8190A/M8121A Disabled Disabled 

Trigger Input Enable/Disable Affects all M8190A/M8121A Disabled Disabled 

Force trigger Affects all M8190A/M8121A Locally available for debugging Locally available for debugging 

Force event Not available Locally available for debugging Locally available for debugging 

Run/Stop Enhanced by: Armed, Trigger, 

Armed & Trigger, Stop 

Disabled Disabled 
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4.1 Introduction 

 

 This chapter describes the M8192A Soft Front Panel (SFP).  

 

 

4.2 Launching the M8192A Soft Front Panel 

 

 There are three ways to launch the M8192A Soft Front Panel. They are as following: 

1. From the Start Menu, select All Programs → Keysight → M8192 → M8192 

Soft Front Panel.  

2. From the Keysight Connection Expert, select the discovered M8192 module, 

press the right mouse key to open the context menu and select “Send 

Commands To This Instrument”. 

3. From the Keysight Connection Expert, select the discovered M8192 module, 

select the “Installed Software” tab and press the “Start SFP” button. 
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 The following screen will appear: 

 

 

 Figure 9   M8192A connected to PC 
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 The instrument selection dialog shows the addresses of the discovered M8192A 

modules. Select a module from the list and press “Connect”. 

If no M8192A module is connected to your PC, you can check “Simulation Mode” to 

simulate an M8192A module.  

 

 

 

 Figure 10   M8192A connected in simulation mode 

 

4.3 M8192A Soft Front Panel 

 

 The M8192A Soft Front Panel allows you to: 

• Configure a multi-module group, 

• Control the M8192 trigger input parameters, 

• Synchronously start all channels of the multi-module group.  

It includes the following GUI items: 

• Title Bar 

• Menu Bar 

• Status Bar 

• Tabs (Module, Sync) 

The detailed information on these GUI items is described in the sections that follow. 
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4.3.1 Title Bar 

 

 The title bar contains the standard Microsoft Windows elements such as the window 

title and the icons for minimizing, maximizing, or closing the window. 

 

 

4.3.2 Menu Bar 

 

 The menu bar consists of various pull down menus that provide access to the 

different functions and launch interactive GUI tools. 

The menu bar includes the following pull down menu: 

• File 

• View 

• Utilities 

• Tools 

• Help 

Each pull down menu and its options are described in the following sections. 

 

 

4.3.2.1 File 

 

 The File menu includes the following selections: 

• File → Connect… 

Opens the instrument selection dialog. 

• File → Save Configuration As… 

Saves configuration as a text file. 

• File → Load Configuration… 

Load the previously saved configuration file. 

• File → Exit 

Exits the soft front panel. 
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4.3.2.2 View 

 

 The View menu includes the following selections: 

• View  → Refresh 

Reads the instrument state and updates all fields. 

• View  → Hide 

Minimize the M8192A to notification icon. 

 

 

4.3.2.3 Utilities 

 

 The Utility menu includes the following selections: 

• Utility → Reset 

Resets the instrument, reads the state and updates all fields. 

• Utility → Self Test… 

Opens the “Self Test” window to start the self-test and display the result 

after completion. 

 

 

4.3.2.4 Tools 

 

 The Tools menu includes the following selections: 

• Tools → Monitor Driver Calls 

Opens the “Driver Call Log” window. 
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4.3.2.5 Help 

 

 The Help menu includes the following selections: 

• Help → User Guide 

Opens the M8192A user guide. 

• Help → Driver Help 

Opens the IVI driver online help. 

• Help → Online Support 

Opens the instrument’s product support web page. 

• Help → About 

Displays revision information for hardware, software and firmware. Displays 

the serial number of the connected module. 

 

 

4.3.3 Status Bar 

 

 The Status Bar contains the following two fields from left to right:  

• Connection Status 

− “Not Connected” – No instrument is connected. 

− “Connected: <Instrument resource string>” – An instrument is 

connected. The resource string, for example PXI36::0::0::INSTR is 

displayed.  

− “Simulation Mode” – No real instrument is connected. The user 

interface is in simulation mode. 

Click this field to open the “Connect to Instrument” dialog. 

• Error status 

− “Error” – The connected instrument reported an error. 

− “No Error” – No errors occurred. 

Click this field to open the “Error” window. 

 

 

4.3.4 Tabs (Module/Sync Tabs) 

 

 These tabs are used to configure the most important parameters of the M8192A 

module. 

 

 

4.3.5 Numeric Control Usage 

 

 The numeric control is used to adjust the value and units. Whenever you bring the 

mouse pointer over the numeric control, a tooltip appears which shows the possible 

values in that range. 

 

 



4  M8192A Soft Front Panel  

48  Keysight M8192A User’s Guide 

 

 Figure 11   Tooltip showing possible values in the range 

 

 

 The numeric controls can be used in the following ways: 

• Use the up/down arrows to change the value. The control automatically 

stops at the maximum/minimum allowed value.  

• You can increase or decrease the value starting at a specific portion of the 

value. To do this, place the cursor to the right of the targeted digit and use 

the up/down arrows. This is especially useful when changing a signal 

characteristic that is immediately implemented, and observing the result in 

another instrument. For example, you can change the signal generator’s 

frequency by increments of 10 MHz and observe the measured result in a 

signal analyzer: 

 

 

 

 Figure 12   Typing directly into the field 

 

 • Type directly into the field and press the Enter key. If you enter a value 

outside the allowed range, the control automatically limits the entered 

value to the maximum or minimum allowed value.  

• When you type the value, you can type the first letter of the allowed unit of 

measure to set the units. For example, in the Frequency control you can use 

"H", "K", "M", or "G" to specify hertz, kilohertz, megahertz, or gigahertz, 

respectively. (The control is not case sensitive.) 

The controls allow scientific notation if it is appropriate to the allowed range. Type 

the first decimal number, enter an "E", and omit any trailing zeroes. For example, in 

the Frequency control you can type 2.5e+9 and press Enter to set the frequency to 

2.5 GHz. (The plus sign is automatically inserted if it is omitted.) 
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4.4 Driver Call Log Window 

 

 Use this window to inspect the sequence of SCPI commands used to configure the 

M8192A module. 

 

 

 Figure 13   Driver Call Log Window 

 

 

 It has the following buttons: 

• Save As… 

Saves the Driver Call Log as a text file. 

• Clear History 

Clears the Driver Call Log. 

• Close 

Exits the window. 
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4.5 Errors List Window 

 

 Use this window to view errors, warnings, and information.  

 

 

 Figure 14   Errors List Window 

 

 It has the following controls, signs, and columns: 

1. Open On Error 

Select this check box to automatically open the errors list window whenever an 

error occurs. This window will show error details i.e time stamp and description. 

2.  (Clear All) 

Use this option to clear all the errors from the errors list window. 

3.   or    (Hide Errors List Window or Show Errors List Window) 

Use this toggle option to respectively show or hide the errors list window. It also 

shows total number of errors in the list.  When the window has no errors, the green 

tick icon will appear.  

4.  (Error)   

This icon represents an error.  

5. (Warning)   

This icon represents a warning.  

6. (Information)   

This icon represents an information.  

7. Time Stamp 

This column lists the time stamp of individual errors in the format: 

DD/MM/YYYY HH:MM:SS.  

8. Description 

This column provides the description of individual errors.  

9.  (Window Controls) 

This drop down list provides window control options like: 

− Float 

− Dock  

− Auto Hide  

− Close  
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4.6 Module Tab 

 

 The module panel allows you to discover available M8190A/M8121A modules and to 

define a multi-module group consisting of one master and up to five slave modules. 

The VISA resource strings for available M8190A/M8121A modules are displayed in a 

list under column “VISA Resource”. The drop-down list under column “Mode” 

provides options to specify whether a module will be part of multi-module group or 

not. Select either “Master” or “Slave” to add a module to the multi-module group. 

The option “None” indicates that the module is not part of the group. The module tab 

also allows you to switch between “Configuration” and “Operation” mode using the 

“Configuration Mode” check box. 

 

  

 Figure 15   Module Tab 
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 It has the following controls: 

• Discover: Click this button to find the available M8190A/M8121A modules. 

The modules that are found are displayed in the list. The firmware of the 

modules to be discovered must be running and the modules must be 

entered into the Keysight Connection Expert. 

• M8190A/M8121A Module Selection List: It has following columns: 

− VISA Resource: Displays the visa resource string of the 

M8190A/M8121A module. 

− Model: Displays the model number of the module. 

− Mode: The combo-box in this column can be used to set the multi-

module mode of the module. Select either “Master” or “Slave” to add a 

module to synchronization group. The option “None” is used to indicate 

that the module is not part of the synchronization group. 

− Serial Number: Displays the serial number of M8190A/M8121A 

module. 

− Slot Number: Displays the slot number in AXIe chassis.  

− Chassis: Displays the AXIe chassis information. 

− Identify: The “Identify” button under this column is used to identify a 

module. On clicking this button, the access LED of the 

M8190A/M8121A module will be flashed for 10 seconds. This allows 

easy identification of module in a setup consisting of multiple AXI 

frames and multiple modules. 

• Configuration Mode: This check box can be used to switch between 

“Configuration” and “Operation” mode. The check box is enabled only when 

“Master” module is selected as it is not possible to switch to “Operation” 

mode if no master is selected. Similarly, while in “Operation” mode if signal 

generation is started this check box is disabled. You need to stop the signal 

generation to switch to “Configuration” mode. 

 

 

 

It is recommended to follow the below order when exiting the application: 

• Stop the system. 

• Switch to Configuration Mode. 

• Exit the M8192 Soft Front Panel. 

• Exit any M8190A/M8121A Soft Front Panel if necessary. 

• Exit the M8190A firmware instances if not required any more. 
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4.7 Sync Tab 

 

 The Sync tab allows you to modify parameters that affect all the modules in the 

synchronous system. This tab can be used to: 

• Configure the M8192 trigger input 

• Set trigger threshold and impedance 

• Set the multi-module group in arm mode and send software trigger to start 

signal generation 

• Stop signal generation and disable arm mode.  

 

In addition, the Sync tab provides the graphical representation of: 

• Sys Clk In and Sync Clk Out for master and slave modules 

• Trigger In and Trigger Out for master and slave modules. 

 

 

 

 Figure 16   Sync Tab 
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 The Sync Tab provides following controls: 

• Sys Clk Out: Shows the Sys Clk Out connection to master and slave 

modules. While switching to "Operation" mode if there is no cabling issue 

and Sys Clk Out connections are valid, the output symbols corresponding to 

each module turn "Green". In case of cabling issues, the symbols turn 

"Red". 

• Trigger In On/Off: Use this switch to enable/disable the trigger hardware 

input. When hardware input is disabled, trigger can only be generated 

using software trigger (see “Trigger” and “Arm & Trigger” button 

descriptions below). 

• Trigger Out: Shows the Trigger Out connection to master and slave 

modules. While switching to "Operation" mode if there is no cabling issue 

and Trigger Out connections are valid, the output symbols corresponding to 

each module turn "Green". In case of cabling issues, the symbols turn 

"Red". 

• Trigger mode 

Refer to the note described in the :INITiate:CONTinous[:STATe][?] 

OFF|ON|0|1 command for setting the trigger mode.   

The following trigger modes are available:  

− Continuous – Signal generation starts after a trigger is received. The 

waveform or sequence is repeated endlessly. 

− Triggered – Signal generation is started by a trigger. After the 

waveform or sequence is played once, the next trigger starts the next 

iteration of the waveform or sequence. 

• Threshold: Use the numeric control to enter the threshold level of the 

M8192A trigger input. 

• Impedance: Use this dropdown list to set the impedance of the M8192A 

trigger input.  

• Arm: Press this button to set all channels of the multi-module group to an 

armed state. Signal generation is started after a trigger is received. 

• Trigger: Press this button to send software trigger to all channels of the 

multi-module group for synchronous start of waveform generation. 

• Arm & Trigger: Press this button to set all channels of the multi-module 

group to an armed state and to send software trigger to all channels for 

synchronous start of waveform generation. 

• Stop: Press this button to stop signal generation and arming mode on all 

channels of the multi-module group. 

 

An example to create a triggered waveform is shown in the description of the 

:INIT:IMM command. For details, see :INITiate:IMMediate command.  
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5.1 Introduction 

 

 This chapter describes the SCPI commands that are used to program M8192A 

module. 

 

 

5.2 SCPI Programming 

 

 The SCPI programming is supported by the following three LAN protocols: 

• VXI-11: The Visa Resource String is e.g. “TCPIP0::localhost::inst0::INSTR”. 

• HiSLIP: this protocol is recommended. It offers the functionality of VXI-11 

protocol with better performance that is near socket performance. Visa 

Resource Strings look like “TCPIP0::localhost::hislip0::INSTR”. The correct 

resource string is shown in the M8192A Soft Front Panel’s “About” dialog 

under “ VISA Resource String for…”. To use the HiSlip protocol an I/O 

library such as the Keysight I/O Libraries Suite must be installed. Since the 

protocol is new it might not be supported by the installed I/O library. The 

Keysight I/O Libraries Suite 16.1 and above supports it. However, the 

Keysight I/O Libraries Suite might be installed as secondary I/O library. In 

this case, check if the primary I/O library supports HiSLIP. If it does not, the 

socket protocol must be used. 

• Socket: this protocol can be used with any I/O library or using standard 

operating system socket functionality connecting to port 5025. This 

protocol must be used if the used I/O library is not supporting HiSLIP 

protocol. Visa Resource string looks like 

“TCPIP0::localhost::5025::SOCKET”, the exact resource string can be seen 

in the M8192A Soft Front Panel’s “About” dialog under “ VISA Resource 

String for…”. 

 

 

 

AgM8192 Firmare.exe must be started prior to sending SCPI to the instrument. (See 

AgM8192SFP.exe) 

 
 

5.2.1 AgM8192SFP.exe 

 

 The M8192A Software Front Panel and Firmware are one application. You need to 

start M8192 Soft Front Panel (AgM8192SFP.exe) before sending SCPI commands to 

the instrument. This can be done in the Windows Start menu (Keysight → M8192 → 

M8192 Soft Front Panel). You can open the “About” dialog from the M8192A Soft 

Front Panel to see the VISA Resource String for the different connection types. 
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5.2.1.1 Command Line Arguments 

 

 (See Communication for details about /s, /t, /i, /AutoID, /NoAutoID, /FallBack). 

 

 

 Table 8 Command Line Arguments 

Option  Description 

/Socket socketPort Set the socket port at which the firmware waits for SCPI commands  

/Telnet telnetPort Set the telnet port at which the firmware waits for SCPI commands  

/Inst instrumentNumber  Set the instrument number (instN, hislipN) at which the firmware waits for SCPI commands  

/AutoID Automatically select ports and number for the connections (default behavior).  

/NoAutoID Disable the default behavior; i.e. do not automatically select ports and number for the connections.  

/FallBack Try to find unused ports and number if starting a server fails.  

/r resourceName Visa PXI resource string of the module to connect to, e.g. PXI12::0::0::INSTR. If this is the last parameter on the 

command line, the “/r” can be omitted.  

/Master masterModule Set the M8190A/M8121A clock master module (LAN VISA resource string, i.e. SOCKET, INST, or HiSLIP). 

/Slave slaveModule Add an M8190A/M8121A clock slave module (LAN VISA resource string, i.e. SOCKET, INST, or HiSLIP) 

 

 

5.2.1.2 Communication 

 

 Depending on the command line arguments /s, /t, /i, /AutoID, /NoAutoID, /FallBack, 

the firmware starts several servers to handle SCPI commands. (Refer to the table 

above.) 

/Socket, /Telnet, /Inst: If -1, don’t start the respective servers 

• Defaults:  

− Socket port: 5025 (e.g. TCPIP0::localhost::5025::SOCKET) 

− Telnet port: 5024 

− HiSLIP, VXI-11.3: 0 (e.g. TCPIP0::localhost::hislip0::INSTR, 

TCPIP0::localhost::inst0::INSTR) 
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 /FallBack : If starting a server fails because of a conflict, try using another port or 

number 

• HiSLIP, VXI-11.3: increase the index until a server can be started 

successfully 

• Socket, Telnet: start with the port 60000, then increase it until the servers 

can be started successfully. If neither socket nor telnet is disabled the 

firmware tries to start the servers on two consecutive ports  

• (socket port = telnet port + 1) 

/AutoID : Automatically select ports and number for the connections, which are 

unique per instrument. 

• This is the default behavior; it is not necessary to specify this argument on 

the command line. 

• If only one AXIe module is connected to this PC and it is an M8192 module, 

first try to use the command line arguments /Socket, /Telnet, /Inst or their 

respective default values if they are not specified. If starting the servers 

fails, proceed with the steps below. 

• /Socket, /Telnet, /Inst are ignored (unless they are -1 and a server is 

disabled) 

• If the firmware detects more than one AXIe module, use a special 

mechanism to obtain a number for the HiSLIP and VXI-11.3 servers, which 

makes sure that the firmware uses always the same VISA resource string 

per module 

• The socket and telnet port are then calculated from the HiSLIP index: 

− telnet port = 60000 + 2 * <HiSLIP index> 

− socket port = 60000 + 2 * <HiSLIP index> + 1 

/NoAutoID : Do not automatically select ports and number for the connections, use 

the values specified with /Socket, /Telnet, /Inst or their respective default values 

instead. 

 

If both /NoAutoID and /AutoID are specified, /AutoID overrides /NoAutoID. 
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5.3 Programming Recommendations 

 

 This section lists some recommendations for programming the instrument.  

Start programming from the default setting. The common command for setting the 

default setting is:  

*RST 

The SCPI standard defines a long and a short form of the commands. For fast 

programming speed, it is recommended to use the short forms. The short forms of 

the commands are represented by upper case letters. For example the short form of 

the command to start/begin event to all channels of the multi-module group is:  

: TRIG:BEG 

To improve programming speed it is also allowed to skip optional subsystem 

command parts. Optional subsystem command parts are depicted in square 

brackets, e.g. :TRIGger[:SEQuence][:STARt]:BEGin[:IMMediate] 

If it is important to know whether the last command is completed then send the 

common query:  

*OPC? 

It is recommended to test the new setting which will be programmed on the 

instrument by setting it up manually. When you have found the correct setting, then 

use this to create the program. 

In the program it is recommended to send the command for starting data generation 

(:INIT:IMM) as the last command. This way intermediate stop/restarts are avoided 

and optimum execution performance is achieved. 

*RST  # set default settings 

...  # other commands to set modes 

...  # and parameters 

:ARM:TRIG:IMP HIGH # set trigger impedance to High 

:INIT:IMM # start data generation. 
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5.4 System Related Commands (SYSTem Subsystem) 

 

5.4.1 :SYSTem:ERRor[:NEXT]? 

 
Command :SYST:ERR? 

Long :SYSTem:ERRor? 

Parameters None 

Parameter Suffix None 

Description Read and clear one error from the instrument’s error queue.  

A record of up to 30 command syntax or hardware errors can be stored in the error 

queue. Errors are retrieved in first-in-first-out (FIFO) order. The first error returned is 

the first error that was stored. Errors are cleared as you read them.  

If more than 30 errors have occurred, the last error stored in the queue (the most 

recent error) is replaced with “Queue overflow”. No additional errors are stored until 

you remove errors from the queue. 

If no errors have occurred when you read the error queue, the instrument responds 

with 0,“No error”. 

The error queue is cleared by the *CLS command, when the power is cycled, or 

when the firmware is re-started. 

The error queue is not cleared by a reset (*RST) command. 

The error messages have the following format (the error string may contain up to 255 

characters):  

error number,”Description”, e.g.  

-113,”Undefined header”. 

Example Query 

:SYST:ERR? 

 

 

5.4.2 :SYSTem:HELP:HEADers? 
 

 

Command :SYST:HELP:HEAD? 

Long :SYSTem:HELP:HEADers? 

Parameters None 

Parameter Suffix None 

Description The HEADers? query returns all SCPI commands and queries and IEEE 488.2 

common commands and common queries implemented by the instrument. The 

response is a <DEFINITE LENGTH ARBITRARY BLOCK RESPONSE DATA> element. 

The full path for every command and query is returned separated by linefeeds. The 

syntax of the response is defined as: The <nonzero digit> and sequence of <digit> 

follow the rules in IEEE 488.2, Section 8.7.9. An <SCPI header> is defined as: It 

contains all the nodes from the root. The <SCPI program mnemonic> contains the 

node in standard SCPI format. The short form uses uppercase characters while the 

additional characters for the long form are in lowercase characters. Default nodes 

are surrounded by square brackets ([]). 

Example Query 

:SYST:HELP:HEAD? 
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5.4.3 :SYSTem:LICense:EXTended:LIST? 
 

 

Command :SYST:LIC:EXT:LIST? 

Long :SYSTem:LICense:EXTended:LIST? 

Parameters None 

Parameter Suffix None 

Description This query lists the licenses installed. 

Example Query 

:SYST:LIC:EXT:LIST? 

 

 

5.4.4 :SYSTem:SET[?] 

 

 
Command :SYST:SET[?] 

Long :SYSTem:SET[?] 

Parameters <binary block data> 

Parameter Suffix None 

Description In query form, the command reads a block of data containing the instrument’s 

complete set-up. The set-up information includes all parameter and mode settings, 

but does not include the contents of the instrument setting memories or the status 

group registers. The data is in a binary format, not ASCII, and cannot be edited. 

In set form, the block data must be a complete instrument set-up read using the 

query form of the command. 

This command has the same functionality as the *LRN command. 

Example Command 

:SYST:SET <binary block data> 

 

Query 

:SYST:SET? 

 

 

5.4.5 :SYSTem:VERSion? 

 

 
Command :SYST:VERS? 

Long :SYSTem:VERSion? 

Parameters None 

Parameter Suffix None 

Description This query returns a formatted numeric value corresponding to the SCPI version 

number for which the instrument complies, for example “1999.0”. 

Example Query 

:SYST:VERS? 
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5.4.6 :SYSTem:COMMunicate:*? 

 

 These queries return information about the instrument firmware’s available 

connections. If a connection is not available the returned value is -1. 

This is only useful if there is more than one Keysight module connected to a PC, 

otherwise one would normally use the default connections (HiSLIP and VXI-11 

instrument number 0, socket port 5025, telnet port 5024) 

One can never be sure if a socket port is already in use, so one could e.g. specify a 

HiSLIP number on the command line (AgM8192Firmware.exe /AutoID /i 5 

/FallBack /r …) and let the firmware find an unused socket port. Then this 

socket port can be queried using the HiSLIP connection. 

 

 

5.4.6.1 :SYSTem:COMMunicate:INSTr[:NUMBer]? 

 

 
Command :SYST:COMM:INST? 

Long :SYSTem:COMMunicate:INSTr? 

Parameters None 

Parameter Suffix None 

Description This query returns the VXI-11 instrument number used by the firmware. 

Example Query 

:SYST:COMM:INST? 

 

 

5.4.6.2 :SYSTem:COMMunicate:HISLip[:NUMBer]? 

 

 
Command :SYST:COMM:HISL? 

Long :SYSTem:COMMunicate:HISLip? 

Parameters None 

Parameter Suffix None 

Description This query returns the HiSLIP number used by the firmware. 

Example Query 

:SYST:COMM:HISL? 
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5.4.6.3 :SYSTem:COMMunicate:SOCKet[:PORT]? 

 

 

Command :SYST:COMM:SOCK? 

Long :SYSTem:COMMunicate:SOCKet? 

Parameters None 

Parameter Suffix None 

Description This query returns the socket port used by the firmware. 

Example Query 

:SYST:COMM:SOCK? 

 

 

5.4.6.4 :SYSTem:COMMunicate:TELNet[:PORT]? 

 

 

Command :SYST:COMM:TELN? 

Long :SYSTem:COMMunicate:TELNet? 

Parameters None 

Parameter Suffix None 

Description This query returns the telnet port used by the firmware. 

Example Query 

:SYST:COMM:TELN? 
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5.5 Common Command List 
 

5.5.1 *IDN? 

 Read the instrument’s identification string, which contains four fields separated by 

commas. The first field is the manufacturer’s name, the second field is the model 

number, the third field is the serial number, and the fourth field is a revision code 

which contains four numbers separated dots and a fifth number separated by a dash: 

Keysight Technologies, M8192A,<serial number>, x.x.x.x-h 

x.x.x.x= Firmware revision number, e.g. 2.0.0.0 

h= Hardware revision number 

5.5.2 *CLS 

 

 Clear the event register in all register groups. This command also clears the error 

queue and cancels a *OPC operation. It doesn’t clear the enable register. 

5.5.3 *ESE 

 

 Enable bits in the Standard Event Status Register to be reported in the Status Byte. 

The selected bits are summarized in the “Standard Event” bit (bit 5) of the Status 

Byte Register. The *ESE? query returns a value which corresponds to the binary-

weighted sum of all bits enabled decimal by the *ESE command. These bits are not 

cleared by a *CLS command. Value Range: 0–255. 

5.5.4 *ESR? 

 

 Query the Standard Event Status Register. Once a bit is set, it remains set until 

cleared by a *CLS (clear status) command or queried by this command. A query of 

this register returns a decimal value which corresponds to the binary-weighted sum 

of all bits set in the register. 

5.5.5 *OPC 

 

 Set the “Operation Complete” bit (bit 0) in the Standard Event register after the 

previous commands have been completed. 

5.5.6 *OPC? 

 

 Return “1” to the output buffer after the previous commands have been completed. 

Other commands cannot be executed until this command completes. 

5.5.7 *OPT? 

 

 Read the installed options. The response consists of any number of fields separated 

by commas. 
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5.5.8 *RST 

 

 Reset instrument to its factory default state. 

 

5.5.9 *SRE[?] 

 

 Enable bits in the Status Byte to generate a Service Request. To enable specific bits, 

you must write a decimal value which corresponds to the binary-weighted sum of the 

bits in the register. The selected bits are summarized in the “Master Summary” bit 

(bit 6) of the Status Byte Register. If any of the selected bits change from “0” to “1”, a 

Service Request signal is generated. The *SRE? query returns a decimal value which 

corresponds to the binary-weighted sum of all bits enabled by the *SRE command. 

5.5.10 *STB? 

 

 Query the summary (status byte condition) register in this register group. This 

command is similar to a Serial Poll but it is processed like any other instrument 

command. This command returns the same result as a Serial Poll but the “Master 

Summary” bit (bit 6) is not cleared by the *STB? command. 

5.5.11 *TST? 

 

 Execute Self Tests. If self-tests pass, a 0 is returned. A number lager than 0 indicates 

the number of failed tests.  

To get actual messages, use :TEST:TST? 

5.5.12 *LRN? 

 

 Query the instrument and return a binary block of data containing the current 

settings (learn string). You can then send the string back to the instrument to restore 

this state at a later time. For proper operation, do not modify the returned string 

before sending it to the instrument. Use :SYST:SET to send the learn string. See 

section 5.4.4. 

5.5.13 *WAI 

 

 Prevents the instrument from executing any further commands until the current 

command has finished executing. 
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5.6 Status Model 

 
Introduction This section describes the structure of the SCPI status system used by the M8192A. 

The status system records various conditions and states of the instrument in several 

register groups as shown on the following pages. Each of the register groups is made 

up of several low level registers called Condition registers, Event registers, and 

Enable registers which control the action of specific bits within the register group.  

These groups are explained below: 

• A condition register continuously monitors the state of the instrument. The 

bits in the condition register are updated in real time and the bits are not 

latched or buffered. This is a read-only register and bits are not cleared 

when you read the register. A query of a condition register returns a 

decimal value which corresponds to the binary-weighted sum of all bits set 

in that register. 

• An event register latches the various events from changes in the condition 

register. There is no buffering in this register; while an event bit is set, 

subsequent events corresponding to that bit are ignored. This is a read only 

register. Once a bit is set, it remains set until cleared by query command 

(such as STAT:QUES:EVEN?) or a *CLS (clear status) command. A query 

of this register returns a decimal value which corresponds to the binary-

weighted sum of all bits set in that register. 

• An enable register defines which bits in the event register will be reported 

to the Status Byte register group. You can write to or read from an enable 

register. A *CLS (clear status) command will not clear the enable register 

but it does clear all bits in the event register. A STAT:PRES command 

clears all bits in the enable register. To enable bits in the enable register to 

be reported to the Status Byte register, you must write a decimal value 

which corresponds to the binary weighted sum of the corresponding bits. 

• Transition Filters are used to detect changes of the state in the condition 

register and set the corresponding bit in the event register. You can set 

transition filter bits to detect positive transitions (PTR), negative transitions 

(NTR) or both. Transition filters are read/write registers. They are not 

affected by *CLS. 



Remote Programming  5 

Keysight M8192A User’s Guide  67 

 

 Figure 17   Status Register Structure 
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5.6.1 :STATus:PRESet 

 

 Clears all status group event registers. Presets the status group enables PTR and 

NTR registers as follows:  

ENABle = 0x0000, PTR = 0xffff, NTR = 0x0000 

 

 

5.6.2 Status Byte Register 

 

 The Status Byte summary register reports conditions from the other status registers. 

Data that is waiting in the instrument’s output buffer is immediately reported on the 

“Message Available” bit (bit 4) for example. Clearing an event register from one of the 

other register groups will clear the corresponding bits in the Status Byte condition 

register. Reading all messages from the output buffer, including any pending queries, 

will clear the “Message Available” bit. To set the enable register mask and generate 

an SRQ (service request), you must write a decimal value to the register using the 

*SRE command. 

 

 

 Table 9 Status Byte Register 

Bit Number Decimal Value Definition 

0 Not used 1 Not Used. Returns “0” 

1 Not used 2 Not Used. Returns “0” 

2 Error Queue 4 One or more errors are stored in the Error Queue 

3 Questionable Data 8 One or more bits are set in the Questionable Data Register (bits must be 

enabled) 

4 Message Available 16 Data is available in the instrument’s output buffer 

5 Standard Event 32 One or more bits are set in the Standard Event Register 

6 Master Summary 64 One or more bits are set in the Status Byte Register 

7 Operational Data 128 One or more bits set in the Operation Data Register (bits must be enabled) 
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5.6.3 Questionable Data Register Command Subsystem 

 

 The Questionable Data register group provides information about the quality or 

integrity of the instrument. Any or all of these conditions can be reported to the 

Questionable Data summary bit through the enable register. 

 

 

 Table 10 Questionable Data Register 

Bit Number Decimal Value Definition 

0          SYSClock Status warning 1 One or multiple system clock outputs have been switched off 

(to protect themselves). 

1          Not used 2 Returns “0” 

2          Not used 4 Returns “0” 

3          Not used 8 Returns “0” 

4          Not used 16 Returns “0” 

5          Not used 32 Returns “0” 

6          Not used 64 Returns “0” 

7          Not used 128 Returns “0” 

8          Not used 256 Returns “0” 

9          Not used 512 Returns “0” 

10        Not used 1024 Returns “0” 

11        Not used 2048 Returns “0” 

12        Not used 4096 Returns “0” 

13        Not used 8192 Returns “0” 

14        Not used 16384 Returns “0” 

15        Not used 32768 Returns “0” 
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 The following commands access the questionable status group. 

 

5.6.3.1 :STATus:QUEStionable[:EVENt]? 

 

 Reads the event register in the questionable status group. It’s a read-only register. 

Once a bit is set, it remains set until cleared by this command or the *CLS 

command. A query of the register returns a decimal value which corresponds to the 

binary-weighted sum of all bits set in the register. 

 

5.6.3.2 :STATus:QUEStionable:CONDition? 

 

 Reads the condition register in the questionable status group. It’s a read-only 

register and bits are not cleared when you read the register. A query of the register 

returns a decimal value which corresponds to the binary-weighted sum of all bits set 

in the register. 

 

5.6.3.3 :STATus:QUEStionable:ENABle[?] 

 

 Sets or queries the enable register in the questionable status group. The selected 

bits are then reported to the Status Byte. A *CLS will not clear the enable register 

but it does clear all bits in the event register. To enable bits in the enable register, 

you must write a decimal value which corresponds to the binary-weighted sum of the 

bits you wish to enable in the register. 

 

5.6.3.4 :STATus:QUEStionable:NTRansition[?] 

 

 Sets or queries the negative-transition register in the questionable status group. A 

negative transition filter allows an event to be reported when a condition changes 

from true to false. Setting both positive/negative filters true allows an event to be 

reported anytime the condition changes. Clearing both filters disable event reporting. 

The contents of transition filters are unchanged by *CLS and *RST. 
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5.6.3.5 :STATus:QUEStionable:PTRansition[?] 

 

 Set or queries the positive-transition register in the questionable status group. A 

positive transition filter allows an event to be reported when a condition changes 

from false to true. Setting both positive/negative filters true allows an event to be 

reported anytime the condition changes. Clearing both filters disable event reporting. 

The contents of transition filters are unchanged by *CLS and *RST. 

 

5.6.4 Operation Status Subsystem 

 

 The Operation Status register contains conditions which are part of the instrument’s 

normal operation. 

 

 Table 11 Operation Status Register 

Bit Number Decimal Value Definition 

0          Not used 1 Returns “0” 

1          Not used 2 Returns “0” 

2          Not used 4 Returns “0” 

3          Not used 8 Returns “0” 

4          Not used 16 Returns “0” 

5          Not used 32 Returns “0” 

6          Not used 64 Returns “0” 

7          Not used 128 Returns “0” 

8          Run Status 256 Indicates if the multi-module group is in running/armed state 

(:INIT:IMM was executed). 

9          Not used 512 Returns “0” 

10        Not used 1024 Returns “0” 

11        Not used 2048 Returns “0” 

12        Not used 4096 Returns “0” 

13        Not used 8192 Returns “0” 

14        Not used 16384 Returns “0” 

15        Not used 32768 Returns “0” 

  
 

 

 The following commands access the operation status group. 

 

5.6.4.1 :STATus:OPERation[:EVENt]? 

 

 Reads the event register in the operation status group. It’s a read-only register. Once 

a bit is set, it remains set until cleared by this command or *CLS command. A query 

of the register returns a decimal value which corresponds to the binary-weighted 

sum of all bits set in the register. 
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5.6.4.2 :STATus:OPERation:CONDition? 

 

 Reads the condition register in the operation status group. It’s a read-only register 

and bits are not cleared when you read the register. A query of the register returns a 

decimal value which corresponds to the binary-weighted sum of all bits set in the 

register. 

 

5.6.4.3 :STATus:OPERation:ENABle[?] 

 

 Sets or queries the enable register in the operation status group. The selected bits 

are then reported to the Status Byte. A *CLS will not clear the enable register but it 

does clear all bits in the event register. To enable bits in the enable register, you 

must write a decimal value which corresponds to the binary-weighted sum of the bits 

you wish to enable in the register. 

 

5.6.4.4 :STATus:OPERation:NTRansition[?] 

 

 Sets or queries the negative-transition register in the operation status group. A 

negative transition filter allows an event to be reported when a condition changes 

from true to false. Setting both positive/negative filters true allows an event to be 

reported anytime the condition changes. Clearing both filters disable event reporting. 

The contents of transition filters are unchanged by *CLS and *RST. 
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5.6.4.5 :STATus:OPERation:PTRansition[?] 

 

 Set or queries the positive-transition register in the operation status group. A positive 

transition filter allows an event to be reported when a condition changes from false 

to true. Setting both positive/negative filters true allows an event to be reported 

anytime the condition changes. Clearing both filters disable event reporting. The 

contents of transition filters are unchanged by *CLS and *RST. 

 

 

5.6.5 Run Status Subsystem 

 

 The Run Status register contains the run status conditions of the multi-module 

group. 

The following SCPI commands and queries are supported: 

:STATus:OPERation:RUN[:EVENt]? 

:STATus:OPERation:RUN:CONDition?  

:STATus:OPERation:RUN:ENABle[?]  

:STATus:OPERation:RUN:NTRansition[?]  

:STATus:OPERation:RUN:PTRansition[?] 

 

 

 Table 12 Run Status Register 

Bit Number Decimal Value Definition 

0          Run Status 1 Indicates if the multi-module group is in running/armed state (:INIT:IMM 

was executed). 
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5.7 :ARM/TRIGger Subsystem 

 

5.7.1 :ABORt 

 
Command :ABOR 

Long :ABORt 

Parameters None 

Parameter Suffix None 

Description Stop signal generation on all channels of the multi-module group. 

Example Command 

:ABOR 

 

 

5.7.2 :INITiate:CONTinous[:STATe][?] OFF|ON|0|1 

 

 

 

Normally triggers are sent by the M8192A to the M8190A/M8121A modules as rising 

edges. It can happen that the trigger to start signal generation is already sent to the 

M8190A/M8121A modules by the M8192A, when there is high a level signal present 

on the trigger input of the M8192A. The M8192A trigger input is routed through two 

synchronization flip-flops, then passed on to the M8190A/M8121A. The flip-flops are 

held in reset while the M8190A/M8121A modules are set up and armed. This is 

necessary because the process of arming the M8190A/M8121A modules happens 

sequentially and it must be guaranteed that during that time no trigger pulses are 

forwarded to the M8190A/M8121A modules. As soon as all of the M8190A/M8121A 

modules are ready, the reset on the synchronization flip flops is released. If there is a 

high-level signal present on the trigger input at that time, it will cause an immediate 

trigger edge for the M8190A/M8121A modules. 

If this behavior is not acceptable it is recommended to use some external “gating” 

circuitry that disables the trigger signal until the system has been started and then 

enables the trigger signal. 

 
 

 
Command :INIT:CONT[:STAT][?] 

Long :INITiate:CONTinuous[:STATe][?] 

Parameters OFF | ON | 0 | 1 

Parameter Suffix None 

Description Set or query the continuous mode. 

• 0/OFF – Continuous mode is off, that is the mode is “triggered”. Signal 

generation is started by a trigger. After the waveform or sequence is played 

once, the next trigger starts the next iteration of the waveform or sequence.  

• 1/ON – Continuous mode is on. Signal generation is started by a trigger. 

The waveform or sequence is repeated endlessly 
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Example Command 

:INIT:CONT:STAT ON 

 

Query 

:INIT:CONT:STAT?       

 

 

5.7.3 :INITiate:IMMediate 

 
Command :INIT:IMM 

Long :INITiate:IMMediate 

Parameters None 

Parameter Suffix None 

Description Set all channels of the multi-module group to an armed state. Signal generation is 

started after a trigger is received. 

Example The following commands create a triggered waveform. 

// Create a synchronous system using the multi-module configuration commands 

// from the INSTrument Subsystem. 

// Load waveforms into all channels of the M8190A/M8121A modules. 

// Set triggered mode. 

:INIT:CONT 0 

// Leave configuration mode and enter operation mode. 

:INST:MMOD:CONF 0 

// Set the advancement modes on all M8190A/M8121A channels to “Auto”. 

// Start signal generation. 

:INIT:IMM 

// On every software trigger the waveform is generated once. 

:TRIG:BEG 

 

5.7.4 :ARM[:SEQuence][:STARt][:LAYer]:TRIGger:LEVel[?] <level>|MINimum|MAXimum 

 

Command :ARM[:SEQ][:STAR][:LAY]:TRIG:LEV[?] 

Long :ARM[:SEQuence][:STARt][:LAYer]:TRIGger:LEVel[?] 

Parameters <level>|MINimum|MAXimum 

Parameter Suffix Volt (V) or millivolt (mV) 

Description Set or query the threshold level of the M8192A trigger input.  

<level> – Threshold level voltage. 

Example Command 

:ARM:TRIG:LEV 3e-9 

 

Query 

:ARM:TRIG:LEV? 
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5.7.5 :ARM[:SEQuence][:STARt][:LAYer]:TRIGger:IMPedance[?] LOW|HIGH 

 

Command :ARM[:SEQ][:STAR][:LAY]:TRIG:IMP[?] 

Long :ARM[:SEQuence][:STARt][:LAYer]:TRIGger:IMPedance[?] 

Parameters LOW|HIGH 

Parameter Suffix None 

Description Set or query the impedance of the M8192A trigger input.  

LOW – low impedance (50 Ω) 

HIGH – high impedance (1 kΩ) 

Example Command 

:ARM:TRIG:IMP HIGH 

 

Query 

:ARM:TRIG:IMP? 

 

 

5.7.6 :TRIGger[:SEQuence][:STARt]:BEGin[:IMMediate] 

 

Command :TRIG[:SEQ][:STAR]:BEG[:IMM] 

Long :TRIGger[:SEQuence][:STARt]:BEGin[:IMMediate] 

Parameters None 

Parameter Suffix None 

Description Send the start/begin event to all channels of the multi-module group. 

Example Command 

:TRIG:BEG  

 

 

5.7.7 :TRIGger[:SEQuence][:STARt]:BEGin:HWDisable[:STATe][?] 0|1|OFF|ON 

 

Command :TRIG[:SEQ][:STAR]:BEG:HWD[:STAT][?] 

Long :TRIGger[:SEQuence][:STARt]:BEGin:HWDisable[:STATe][?] 

Parameters 0|1|OFF|ON 

Parameter Suffix None 

Description Set or query the M8192A’s hardware input disable state for the trigger function. 

When the hardware input is disabled, a trigger can only be generated using the 

:TRIGger[:SEQuence][:STARt]:BEGin[:IMMediate] command. When the hardware 

input is enabled, a trigger can be generated by command or by a signal present at 

the trigger input of the M8192A. 

Example Command 

:TRIG:BEG:HWD ON 

 

Query 

:TRIG:BEG:HWD? 
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5.8 INSTrument Subsystem 

 

5.8.1 :INSTrument:SLOT[:NUMBer]? 

 

Command :INST:SLOT[:NUMB]? 

Long :INSTrument:SLOT[:NUMBer]? 

Parameters None 

Parameter Suffix None 

Description Query the instrument’s slot number in its AXIe frame. 

Example Query 

:INST:SLOT? 
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5.8.2 Multi-module configuration commands 

 

 These commands and queries are used to identify reachable M8190A/M8121A 

modules and to define a multi-module group consisting of one master module and 

up to five slave modules. 

 

5.8.2.1 :INSTrument:MDIScover? 

 

Command :INST:MDIS? 

Long :INSTrument:MDIScover? 

Parameters None 

Parameter Suffix None 

Description This query returns a comma-separated list of VISA resource strings of all 

M8190A/M8121A modules known by the VISA Resource Manager.  

Example Query 

:INST:MDIS? 

 

5.8.2.2 :INSTrument:IDENtify <visa_resource_string> 

 

Command :INST:IDEN 

Long :INSTrument:IDENtify 

Parameters <visa_resource_string> 

Parameter Suffix None 

Description This command toggles the green “Access” LED of the M8190A/M8121A module with 

the passed VISA resource string for 10 seconds. This allows easy identification of one 

module in a setup consisting of multiple AXI frames and multiple modules. 

Example Command 

:INST:IDEN “TCPIP0::localhost::hislip0::INSTR” 

 

5.8.2.3 :INSTrument: SLAVe:LIST? 

 

Command :INST:SLAV:LIST? 

Long :INSTrument:SLAVe:LIST? 

Parameters None 

Parameter Suffix None 

Description This query returns a comma-separated list of VISA resource strings of all 

M8190A/M8121A slave modules that belong to the multi-module group. 

Example Query 

:INST:SLAV:LIST? 
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5.8.2.4 :INSTrument:MMODule:CONFig[?] 0|1|OFF|ON 

 

Command :INST:MMOD:CONF[?] 

Long :INSTrument:MMODule:CONFig[?] 

Parameters 0|1|OFF|ON 

Parameter Suffix None 

Description The command form enables (1|ON) or disables (0|OFF) the multi-module 

configuration mode for the complete multi-module group. The command forms of 

the following SCPIs for master and slave selection are only available in multi-module 

configuration mode. When the multi-module configuration mode is disabled, the 

modifications become active. 

Furthermore, the commands for setting the clocking parameters on the 

M8190A/M8121A master module (DAC output mode, internal sample frequency, 

external sample frequency, sample clock source, reference clock source, and 

reference frequency) are only available in multi-module configuration mode. 

The query form returns the state of the multi-module configuration mode. 

Example Command 

:INST:MMOD:CONF ON 

 

Query 

:INST:MMOD:CONF? 

 

 

5.8.2.5 :INSTrument:SLAVe:ADD < visa_resource_string> 

 

Command :INST:SLAV:ADD 

Long :INSTrument:SLAVe:ADD 

Parameters < visa_resource_string> 

Parameter Suffix None 

Description This command adds the M8190A/M8121A module with the passed VISA resource 

string as slave to the multi-module group. 

Example Command 

:INST:SLAV:ADD “TCPIP0::localhost::hislip0::INSTR” 

 

 

5.8.2.6 :INSTrument: SLAVe:DELete < visa_resource_string> 

 

Command :INST:SLAV:DEL 

Long :INSTrument:SLAVe:DELete 

Parameters < visa_resource_string> 

Parameter Suffix None 

Description This command deletes the M8190A/M8121A slave module with the passed VISA 

resource string from the multi-module group. 

Example Command 

:INST:SLAV:DEL “TCPIP0::localhost::hislip0::INSTR” 
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5.8.2.7 :INSTrument: SLAVe:DELete:ALL 

 

Command :INST:SLAV:DEL:ALL 

Long :INSTrument:SLAVe:DELete:ALL 

Parameters None 

Parameter Suffix None 

Description This command deletes all M8190A/M8121A slave modules from the multi-module 

group. 

Example Command 

:INST:SLAV:DEL:ALL  

 

5.8.2.8 :INSTrument:MASTer[?][<visa_resource_string>] 

 

Command :INST:MAST[?] 

Long :INSTrument:MASTer[?] 

Parameters <visa_resource_string> 

Parameter Suffix None 

Description The command form selects the M8190A/M8121A module with the passed VISA 

resource string as master.  

The query form returns the VISA resource string of the M8190A/M8121A module that 

is the master or an empty string, if no master is selected.  

Example Command 

:INST:MAST “TCPIP0::localhost::hislip0::INSTR” 

 

Query 

:INST:MAST? 

 

 

5.9 MMEMory Subsystem 

 

 

MMEM commands requiring <directory_name> assume the current directory if a 

relative path or no path is provided. If an absolute path is provided, then it is ignored. 

 
 

5.9.1 :MMEMory:CATalog? [<directory_name>] 

 
Command :MMEM:CAT? 

Long :MMEMory:CATalog? 

Parameters None 

Parameter Suffix None 
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Description Query disk usage information (drive capacity, free space available) and obtain a list of 

files and directories in a specified directory in the following format: 

<numeric_value>,<numeric_value>,{<file_entry>}  

This command returns two numeric parameters and as many strings as there are files 

and directories. The first parameter indicates the total amount of storage currently 

used in bytes. The second parameter indicates the total amount of storage available, 

also in bytes. The <file_entry> is a string. Each <file_entry> indicates the name, type, 

and size of one file in the directory list:  

<file_name>,<file_type>,<file_size>  

As the Windows file system has an extension that indicates file type, <file_type> is 

always empty. <file_size> provides the size of the file in bytes. In case of directories, 

<file_entry> is surrounded by square brackets and both <file_type> and <file_size> 

are empty. 

Example Query 

:MMEM:CAT? 

 

 

5.9.2 :MMEMory:CDIRectory [<directory_name>] 

 
Command :MMEM:CDIR 

Long :MMEMory:CDIRectory 

Parameters None 

Parameter Suffix None 

Description Changes the default directory for a mass memory file system. The <directory_name> 

parameter is a string. If no parameter is specified, the directory is set to the *RST 

value. At *RST, this value is set to the default user data storage area, that is defined 

as System.Environment.SpecialFolder.Personal 

e.g. C:\Users\Name\Documents 

MMEMory:CDIRectory? — Query returns full path of the default directory. 

Example Command 

:MMEM:CDIR “C:\Users\Name\Documents” 

 

Query  

:MMEM:CDIR? 

 

 

5.9.3 :MMEMory:COPY <string>,<string>[,<string>,<string>] 

 
Command :MMEM:COPY 

Long :MMEMory:COPY 

Parameters <string>,<string> 

Parameter Suffix None 
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Description Copies an existing file to a new file or an existing directory to a new directory. Two 

forms of parameters are allowed. The first form has two parameters. In this form, the 

first parameter specifies the source, and the second parameter specifies the 

destination. 

The second form has four parameters. In this form, the first and third parameters 

specify the file names. The second and fourth parameters specify the directories. The 

first pair of parameters specifies the source. The second pair specifies the 

destination. An error is generated if the source doesn't exist or the destination file 

already exists. 

Example Command 

:MMEM:COPY "C:\data.txt", "C:\data_new.txt" 

 

5.9.4 :MMEMory:DELete <file_name>[,<directory_name>] 

 
Command :MMEM:DEL 

Long :MMEMory:DELete 

Parameters <file_name> 

Parameter Suffix None 

Description Removes a file from the specified directory. The <file_name> parameter specifies the 

file to be removed. 

Example Command 

:MMEM:DEL "C:\data.txt" 

 

5.9.5 :MMEMory:DATA <file_name>, <data> 

 
Command :MMEM:DATA 

Long :MMEMory:DATA 

Parameters <file_name>, <data> 

Parameter Suffix None 

Description The command form is MMEMory:DATA <file_name>,<data>. It loads <data> 

into the file <file_name>. <data> is in 488.2 block format. <file_name> is string data. 

Example Command 

:MMEM:DATA “C:\data.txt”, #14test 

 

5.9.6 :MMEMory:DATA? <file_name> 

 

 
Command :MMEM:DATA? 

Long :MMEMory:DATA? 

Parameters <file_name> 

Parameter Suffix None 

Description The query form is MMEMory:DATA? <file_name> with the response being the 

associated <data> in block format. 

Example Query 

:MMEM:DATA? "C:\data.txt"  
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5.9.7 :MMEMory:MDIRectory <directory_name> 

 
Command :MMEM:MDIR 

Long :MMEMory:MDIRectory 

 
Parameters <directory_name> 

Parameter Suffix None 

Description Creates a new directory. The <directory_name> parameter specifies the name to be 

created. 

Example Command 

:MMEM:MDIR "C:\data_dir" 

 

 

5.9.8 :MMEMory:MOVE <string>,<string>[,<string>,<string>] 

 
Command :MMEM:MOVE 

Long :MMEMory:MOVE 

Parameters <string>,<string>[,<string>,<string>] 

Parameter Suffix None 

Description Moves an existing file to a new file or an existing directory to a new directory. Two 

forms of parameters are allowed. The first form has two parameters. In this form, the 

first parameter specifies the source, and the second parameter specifies the 

destination.  

The second form has four parameters. In this form, the first and third parameters 

specify the file names. The second and fourth parameters specify the directories. The 

first pair of parameters specifies the source. The second pair specifies the 

destination. An error is generated if the source doesn't exist or the destination file 

already exists. 

Example Command 

:MMEM:MDIR "C:\data_dir","C:\newdata_dir" 

 

 

5.9.9 :MMEMory:RDIRectory <directory_name> 

 
Command :MMEM:RDIR 

Long :MMEMory:RDIRectory 

Parameters <directory_name > 

Parameter Suffix None 

Description Removes a directory. The <directory_name> parameter specifies the directory name 

to be removed. All files and directories under the specified directory are also 

removed. 

Example Command 

:MMEM:RDIR "C:\newdata_dir" 
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5.9.10 :MMEMory:LOAD:CSTate <file_name> 

 
Command :MMEM:LOAD:CST 

Long :MMEMory:LOAD:CSTate 

Parameters <file_name > 

Parameter Suffix None 

Description Current STate of instrument is loaded from a file. 

Example Command 

:MMEM:LOAD:CST "C:\data.txt" 

 

5.9.11 :MMEMory:STORe:CSTate <file_name> 

 
Command :MMEM:STOR:CST 

Long :MMEMory:STORe:CSTate 

Parameters <file_name > 

Parameter Suffix None 

Description Current STate of instrument is stored to a file. 

Example Command 

:MMEM:STOR:CST "C:\data.txt" 
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5.10 TEST Subsystem 

 

5.10.1 :TEST:PON? 

 
Command :TEST:PON? 

Long :TEST:PON? 

Parameters None 

Parameter Suffix None 

Description Return the results of the power on self-tests. 

Example Query 

:TEST:PON? 

 

5.10.2 :TEST:TST? 

 
Command :TEST:TST? 

Long :TEST:TST? 

Parameters None 

Parameter Suffix None 

Description Same as *TST?, but the actual test messages are returned. 

Example Query 

:TEST:TST? 

 

 

Currently same as :TEST:PON? 
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6.1 Performance Specification 

 

 The performance specification can be found in the data sheet available at: 

http://www.Keysight.com/find/M8192A 

 

6.2 General 

 

 Table 13 Characteristics 

Characteristics Description 

Power consumption 60 W 

Operating temperature 0 °C to 40 °C 

Storage temperature  -40 °C to 70 °C 

Operating humidity 5 % to 80 % relative humidity 

Operating altitude up to 2000 m 

Safety designed to  IEC61010-1, UL61010, CSA22.2 61010.1 tested 

Interface to controlling PC PCIe (see AXIe chassis specification) 

Form factor 1-slot AXIe module 

Dimensions (W x H x D) 351 mm x 29 mm x 310 mm 

Weight 3.1 kg 

Warm-up time  30 minutes 

Calibration interval  2 years recommended 

Cooling  

Requirements 
When operating the M8192A, choose a location that provides at least 80 mm of clearance at rear, and at 

least 30 mm of clearance at each side for the AXIe chassis. 

 

 

WARNING 
 

The instrument is not designed for outdoor use. Do not expose the instrument to rain 

or other excessive moisture. Protect the instrument from humidity and temperature 

changes, which could cause condensation within the instrument.  

Do not operate the instrument in the presence of flammable gases, fumes or 

powders. Operation of any electrical instrument in such an environment constitutes a 

definite safety hazard. 

 
  

http://www.agilent.com/find/M8192A
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6.3 Maintenance 

 

6.3.1 ESD Protection 

 

 

 

 

 

 

 

 

CAUTION 
 

All the connectors are very sensitive to electrostatic discharge (ESD). When you 

connect a device or cable that is not fully discharged to these connectors, you risk 

damage to the instrument and expensive instrument repairs. 

 
 

CAUTION 
 

Electrostatic discharge (ESD) can damage the circuits of the M8192A. Avoid applying 

static discharges to the front-panel connectors. Before connecting any coaxial cable 

to the connectors, momentarily short the center and outer conductors of the cable 

together. Avoid touching the front-panel connectors without first touching the frame 

of the instrument. Be sure the instrument and all connected devices (DUT, etc.) are 

properly earth-grounded (to a common ground) to prevent buildup of static charge 

and electrical over-stress. 
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6.3.2 Power and Ventilation Requirements 

 

 For power and ventilation requirements, refer to:  

• http://www.Keysight.com/find/M9505A for 5-slot chassis related 

documentation. 

• http://www.Keysight.com/find/M9502A for 2-slot chassis related 

documentation. 

 

6.3.3 Thermal Protection 

 

Overheating Detection The instrument monitors its internal temperature. If the temperature exceeds 

approximately 80 °C the power supply is switched off. The instrument will not turn on 

automatically if the temperature is decreasing again. 

 

Fan Failure If a fan is broken or prevented from operating by a blockage the temperature will 

increase. When the temperature exceeds approximately 80 °C the overheating 

detection switches off the instrument for safety reasons. For reliability it is 

recommended to send instruments with broken or defective fans immediately to 

Keysight Service for repair. 

 

6.3.4 Cleaning Recommendation 

 

WARNING 
 

To prevent electrical shock, disconnect the instrument from mains before cleaning. 

Use a dry cloth or one slightly dampened with water to clean external case parts. Do 

not attempt to clean internally. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.agilent.com/find/M9505A
http://www.agilent.com/find/M9502A
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